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Unit Overview 
Unit 1 will introduce some fundamental terminology relating to derivatives, 
and will describe some basic features of derivatives contracts. You will 
examine the characteristics of forward contracts, futures contracts and 
options, and you will learn about the types of traders who deal in deriva-
tives, and some of the dangers of their misuse. You will also use data tables 
to construct profit patterns for options. 

Learning outcomes 

When you have completed your study of this unit and its readings, you will 
be able to: 

• discuss and differentiate between the most common types of financial 
derivatives: forward contracts, futures and options 

• explain the advantages of long and short positions in these contracts  
• distinguish between put and call options 
• outline three main reasons for the use of derivatives 
• discuss the potential dangers in misusing derivatives, and how to 

avoid them 
• conduct sensitivity analysis using data tables. 

 Reading for Unit 1 

John C Hull (2018) Options, Futures, and Other Derivatives. Essex UK, 
Pearson. Chapter 1 ‘Introduction’, Chapter 2 ‘Mechanics of futures 
markets’ and Chapter 36 ‘Derivatives mishaps and what we can learn from 
them’. 

Simon Benninga (2014) Financial Modeling. Cambridge MA, The MIT Press. 
Chapter 31 ‘Data tables’. 
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1.1 Introduction 
Derivatives are a general class of financial contracts, which are written in 
terms of an underlying financial or real asset. Their payoff over a given 
period of time will depend on the performance of the underlying asset, 
which could include stocks, interest rates or exchange rates. The value of a 
financial derivative, therefore, depends on the performance of the underly-
ing asset. Financial derivatives include futures and options. They are a flexible 
form of financial instrument, and can be very effective in enabling investors 
to achieve a complex risk profile. In particular, derivatives can be a very 
powerful instrument for reducing risk, or hedging. However, derivatives can 
also be used to increase the risk of investors, if they are used for speculation. 
Finally, derivatives allow investors to make riskless profits by exploiting 
mispricing of assets when they are used for arbitrage. 

The application section in this unit provides an introduction to data tables. 
Data tables are used widely in financial modelling for sensitivity analysis. In 
this section you will construct the profit pattern for a call option on a stock. 
In later units you will study how to use data tables to analyse more sophisti-
cated strategies.  

We begin by looking at types of derivative contracts. 

1.2 Forward Contracts 
The simplest derivative instrument is a forward contract. This is ‘an agree-
ment to buy or sell an asset at a certain future time for a certain price’ (Hull, 
2018: p. 28). You can see that the main feature of forward contracts is that it 
enables you to fix now the price at which a transaction will take place at a 
future date. You can therefore make use of a forward contract in order to 
eliminate the uncertainty associated with the future price of an asset. A 
forward contract can be contrasted to a spot contract, where delivery of the 
asset is immediate. Thus, a forward contract can effectively eliminate the 
uncertainty of the future spot price. 

The reduction of uncertainty could be desirable from the point of view of 
risk management. However, it is important you realise that the elimination 
of uncertainty does not imply that you would always be better off by enter-
ing a forward contract. Indeed, if you successfully hedge your position you 
will be able to eliminate or reduce the losses associated with adverse move-
ments in the price of the underlying asset, but at the cost of foregoing the 
profits associated with potentially favourable asset price changes. 

In order to see this point, denote the delivery price written in the forward 
contract by K and the future spot price on the delivery date by ST. If you 
have a long position in the forward contract – that is, if you commit yourself 
to purchasing the underlying asset at contract maturity – your payoff upon 
maturity will be 
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TS K−  (1.1) 

The value K is written into the contract, but ST is the spot price that will 
prevail in the market at the future delivery date, and cannot be known in 
advance. If ST turns out to be greater than K, you will be able to purchase at 
a price K an asset that has the greater market price ST, and will therefore 
make a profit: . However, if the market price ST happens to be 
less than K, you will have to pay the price K for an asset whose market price 
is only ST, and will therefore make a loss: 0TS K− < . 

If you commit yourself to selling an asset, you will have a short position in the 
forward contract. In this case, your payoff at maturity will be given by: 

TK S−  (1.2) 

Your profits and losses will now be the mirror image to those in a long 
position. You will make a gain if the market price ST is less than the forward 
price K, and will make a loss if ST is greater than K on maturity. 

If you have a long position in an asset, the gains or losses from a long 
position in a forward contract written on that asset will offset the losses or 
gains from your position in the underlying asset. You will therefore be able 
to use forward contracts in order to achieve a hedged position, so that your 
payoff is no longer subject to the asset price uncertainty. 

 Reading 1.1 

Please now stop and read the introduction to Chapter 1 to the end of the section on 
forward contracts of Hull (2018), on pages 23–30. Pay special attention to the numerical 
examples that motivate the use of forward contracts. 

 Exercise 1.1 

Please now solve problem 1.5 on page 41 of Hull (2018). An answer is provided. 

1.3 Futures Contracts 
The forward contracts that you studied in Section 1.2 are usually arranged 
over-the-counter (OTC) by two financial institutions, or by a financial institu-
tion and one of its clients (see the discussion in Section 1.2 on pages 25–26 of 
Hull (2018)). This implies that the characteristics of the contract can be 
customised to the specific needs of the two parties. However, over-the-
counter contracts present the potential disadvantage of involving some 
credit risk (that is, the risk that the counterparty may default on its obliga-
tions), and could also suffer from limited liquidity. For these reasons, 
clearing houses are increasingly required for some OTC transactions. 

By contrast, futures contracts have similar features to forward contracts, but 
are normally traded on an exchange market. This requires that futures con-
tracts be standardised – that is, they must specify in detail the characteristics 
of the particular underlying asset, and must follow standard conventions 

Hull (2018) Chapter 1 
‘Introduction’,  
sections 1.1–1.3 in 
Options, Futures, and 
Other Derivatives. 
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regarding the contract size, the delivery arrangements and the delivery 
dates. This both significantly reduces the credit risk associated with futures 
contracts and makes them much more liquid. 

Futures contracts are traded on markets such as the CME Group (created in 
2007 from the merger between the Chicago Board of Trade (CBOT) and the 
Chicago Mercantile Exchange (CME)), where trade instructions are carried 
out by brokers. As a bona fide insurance against the risk of default, brokers 
usually require that the investor deposits a fund known as the initial margin. 
The initial margin can be modified over the life of the contract, depending 
on the changes in the market value of the futures contract (variation margin). 
In turn, brokers must maintain margins with a clearing house, which acts as 
an intermediary in futures transactions. These are the clearing margins. The 
main role of margins is to reduce the credit risk in futures contracts. 

 Reading 1.2 

Please now read Section 1.4 on page 30 and Chapter 2, pages 46–66 of Hull (2018). 
Section 1.4 provides a brief introduction to futures contracts, whereas Chapter 2 de-
scribes the mechanics of futures margins, including a detailed discussion of the workings 
of margins. Table 2.3 on page 65 usefully summarises the main differences between 
forward and futures contracts. 

 Exercise 1.2 

Please solve problem 1.6 on page 41 of Hull (2018). 

1.4 Options 
Forward and futures contracts constitute a binding commitment for inves-
tors. If an investor has a long position in a forward contract, for instance, she 
is committing herself to completing the contract at maturity and to purchas-
ing the underlying asset. Forward and futures contracts therefore require 
final delivery, unless they are closed out prior to maturity (which is typically 
the case for futures contracts). By contrast, options contracts confer onto their 
holders the right to buy or sell an asset at or before maturity, but do not 
prescribe that the purchase or sale must be executed. In other words, there is 
no obligation involved to carry out the transaction. If it is not profitable to 
do so, the holder of an option contract could choose to let the contract expire 
unexercised. Their only loss would be the initial cost of the option contract. 

An option to buy an asset is a call option, and an option to sell an asset is a put 
option. The price at which the purchase or the sale can be carried out is called 
the strike price, or the exercise price. The price of the option contract is called the 
option premium. Option contracts that can be exercised any time up to and 
including the expiration date are called American options, whereas contracts 
that can only be exercised on the expiration date are called European options. 

Investors who have the right to buy or to sell an asset (in call options or in 
put options, respectively) are said to have a long position. Their counterpar-

Hull (2018) Section 1.4 
‘Futures contracts’, & 
Chapter 2 ‘Mechanics of 
futures markets’ in 
Options, Futures, and 
Other Derivatives. 
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ties, who have issued the options, are said to have a short position: the 
options would be exercised against them. 

The main feature of options contracts is that their payoffs can be strongly 
asymmetric. For instance, if you have a long position in a call option, the 
most you can lose is the premium that you paid for the option. By contrast, 
your gains could potentially be very large, since if the price of the asset 
increases on maturity you could profit from the whole difference between 
the spot price of the asset and the exercise price. The asymmetry in the 
payoff profiles of options makes them a very versatile financial instrument. 

In this module you will examine in detail a number of different option 
contracts, and you will see how they can be combined to achieve a large 
variety of risk profiles for your financial portfolios. 

 Reading 1.3 

Please now stop and read Section 1.5 of Hull (2018), pages 30–33. Pay particular 
attention to the two diagrams in Figure 1.3 on page 33, which illustrate the payoff 
profiles associated with a long position in a call option and a short position in a put 
option on a stock. 

 Exercise 1.3 

Please solve problem 1.7 on page 42 of the book by Hull. 

1.5 Types of Traders 
As noted already, derivatives are very flexible financial instruments. They 
can be used for a variety of purposes, and can be very effective in modifying 
the risk profile of investors. 

There are three main reasons for the use of derivatives.  

• First, they can be used to reduce risk – that is, for hedging. For instance, 
if an investor has a long position in an asset she can hedge her risk by 
taking a short position on a derivative written on the underlying asset.  

• Second, derivatives can be used in order to increase risk – that is, for 
speculation. If you believe that the market is mispricing the probability 
that the price of an asset will change – for instance, you could believe 
that it is more likely that the price of an asset will fall, relative to what 
is expected by the market and is reflected in the asset price. In this 
case, you could speculate by directly taking a short position in the 
asset. However, an alternative strategy could involve taking a short 
position on a derivative written on the asset. Taking a short position 
on a derivative could be more profitable, because futures and options 
can provide a form of leverage. The financial consequences are much 
larger, given the size of the initial investment.  

• Finally, derivatives can be used to exploit potential arbitrage 
opportunities, which could arise, for instance, from small discrepancies 

Hull (2018) Chapter 1, 
section 1.5 ‘Options’ in 
Options, Futures, and 
Other Derivatives. 
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in the pricing of assets across different markets, or from inconsistency 
in the pricing of similar assets. Since arbitrage involves little or no risk, 
large amounts of resources have been devoted to developing software 
programmes that are able to execute automatic transactions whenever 
arbitrage opportunities are seen to arise. 

 Reading 1.4 

Please now read Sections 1.6 to 1.9 of Hull (2018), pages 33–39. You should study 
carefully the examples in Tables 1.4 and 1.5, which illustrate the potential effect of 
leverage when using futures and options for speculative investment. 

 Exercise 1.4 

Please solve problem 1.9 on page 42 of the book by Hull. 

 Exercise 1.5 

Please solve problem 1.16 on page 42 of the book by Hull. 

 Exercise 1.6 

Please answer question 1.21 on page 42 of the book by Hull. 

1.6 A ‘Health Warning’ 
While derivatives are very flexible instruments, if they are misused they can 
lead to potentially catastrophic losses. There has been a number of high-
profile instances of reputable financial institutions being forced to fold 
because of the enormous losses suffered from speculation in the derivatives 
market. It is therefore essential that proper measures are put in place to 
monitor and control the risks associated with trading in derivatives. These 
measures include: 

• setting proper risk limits  
• monitoring traders  
• separating trading execution from book keeping and accounting  
• being aware of the usefulness but also of the limitations of quantitative 

models, and  
• taking liquidity risk seriously.  

These measures will not completely eliminate all risks, but can go a long 
way towards reducing the likelihood of negative outcomes from the trading 
in derivatives. 

Hull (2018) Chapter 1, 
sections 1.6–1.9 in 
Options, Futures, and 
Other Derivatives. 
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 Reading 1.5 

Please now read Section 1.10 and the Summary on pages 39–41 and Chapter 36, pages 
828–39 of Hull (2018). Chapter 36 is towards the end of the book. You may not be able 
to understand yet all the references in the chapter, but it is very useful that you are aware 
of the potential issues in the use of derivatives, and of some of the main measures that 
should be taken in order to avoid the most serious adverse consequences; and you should 
therefore read this chapter now. 

1.7 Application: Data tables 
In this section you will examine one of the tools used extensively in financial 
modelling, data tables, and you will create a data table to show the profit 
patterns from purchasing a call option on a stock. First you will examine a 
function that can be used to make your Excel workbooks more informative. 

1.7.1 FORMULATEXT and Getformula 

In this module you will develop and use relatively complex formulas and 
spreadsheets. To help understand the spreadsheets it would be useful to see 
the formulas contained in particular cells in a workbook. (Excel has the 
facility to Show Formulas in cells instead of the results, available on the 
Formulas tab, but it would be more useful to see the results and the formulas 
at the same time.) 

This can be achieved using the Excel function FORMULATEXT. This func-
tion has the syntax =FORMULATEXT(reference), where ‘reference’ is the cell 
whose formula you would like to display. The function displays the formula 
that is contained in the reference cell, while leaving the results visible in the 
reference cell. 

FORMULATEXT is a built-in Excel function, and it is available in new 
workbooks and any workbooks you create. For this reason it is probably 
most convenient for you to use FORMULATEXT in your own workbooks. 
However, FORMULATEXT was introduced in Excel 2013. If you are using 
an earlier version of Excel you can create a user-defined formula to do the 
same thing, and the instructions to do this are available in Benninga (2014), 
as follows. 

 Study Note 1.1 

In the book by Benninga (2014) and the associated Excel workbooks you will see a 
formula called ‘Getformula’. Getformula is a User-defined formula, and has the same 
effect as FORMULATEXT.  

Advice on Getformula and the instructions to put Getformula into an Excel workbook are 
provided in Chapter 0 ‘Before all else’ in Benninga (2014), Sections 0.2 to 0.6, pages 2–6. 
The code on page 4 is available to copy from the Excel file named ‘FM4, Chapter 00, 
Before you start.xlsm’, on the tab ‘Getformula into VBA’. 

Hull (2018) Chapter 1, 
section 1.10, & Summary 
& Chapter 36 
‘Derivatives mishaps and 
what we can learn from 
them’ in Options, Futures 

   



 Unit 1 Derivatives Contracts 

Centre for Financial and Management Studies  9 

To use the Visual Basic Editor you will need to put the Developer tab on your ribbon. If 
this is not present already, go to File>Options>Customize Ribbon and make sure the 
Developer tab is selected. 

If you follow this approach to define the function, Getformula will now be available in the 
saved workbook, but it will not be available in new workbooks. 

The workbook ‘FM4, Chapter 00, Before you start.xlsm’ already has Getformula defined, 
so you could use this file as the basis for your own workbooks, if you are unable to follow 
these instructions successfully. 

As noted above, if you are using Excel 2013 or later it is probably more convenient to use 
the FORMULATEXT function in your own workbooks, and be aware that Getformula in 
Benninga (2014) and associated Excel workbooks performs the same function. 

 

1.7.2 Data tables 

Data tables are a powerful tool for analysing financial instruments, includ-
ing derivatives, and have wide application in financial modelling. They are 
useful for conducting sensitivity analysis, analysing how the results vary as 
one or other inputs change. To demonstrate how to use a data table we will 
recreate the profit pattern for the call option shown in Figure 1.5 in Hull 
(2018). The profit pattern shows how the option profit changes for a range of 
prices of the underlying stock. 

Intuitively, a data table works like this. For this example we need to create a 
formula for the profit from purchasing a call option on a stock. As you have 
seen in this unit, the profit will depend on: 

• the premium paid to purchase the call option 
• the strike price (also known as the exercise price) 
• the price of the underlying stock at maturity. 

You have seen that if the stock price at maturity is less than the strike price, 
the call option will not be exercised, the payoff will be zero, and the overall 
loss will be the call premium already paid. If the stock price is more than the 
exercise price, the option will be exercised. The payoff will be the positive 
difference between the stock price and the exercise price, and the overall 
profit will be reduced by the call premium already paid. 

In Unit 2 you will examine in more detail the profits for various types of 
options, but based on the above reasoning we can say that the profit from a 
long call option is 

( )max ,0TS K c− −  (1.3) 

where: 

ST is the stock price at maturity, time T 

K is the strike price 

c is the premium paid for the call option. 

If 
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TS K<  
the option would not be exercised, 

( )max ,0 0TS K− =  
and the overall loss equals −c. 

If 

TS K>  
the option will be exercised, 

( )max ,0T TS K S K− = −  
and the overall profit is 

( )TS K c− −  
The data table has two inputs. Firstly, the data table needs to reference the 
formula for the profit from the call option. Secondly, we need to specify a 
range of values for the stock price at maturity. When we have created the 
data table it will show the option profit for each of the values of the stock 
price we have specified. 

We have described the intuition behind a one-dimensional data table – only 
one input is varying in the table, the stock price. We could extend the data 
table with additional formulas, to assess the impact of varying the stock 
price on, for example, the profit from writing a call option, purchasing a put 
option, and writing a put option. But the input being varied is always the 
stock price. Two-dimensional data tables allow you to assess the impact on 
one formula of varying two inputs. For example, we could assess the impact 
on the call option profit of various stock prices and strike prices. 

 Reading 1.6 

Please now read from Chapter 31 ‘Data tables’ in Benninga (2014), Sections 31.1–31.5 
and Section 31.8, pages 823–26 and page 835. These sections explain how to set up a 
data table, using a relatively simple net present value example. 

 

As noted in Benninga, data tables can take up a lot of processing power. 
Excel recalculates formulas in a workbook automatically when there is a 
change in one of the cells on which the formulas are dependent. The Excel 
default recalculation setting is ‘Automatic Except for Data Tables’. For the 
data tables to operate you will need to change the calculation option to 
‘Automatic’ (Formulas>Calculation Options) or use the ‘Calculate Now’ 
button (also on the Formulas tab). 

 Review Question 1.1 

The data table described in this last reading is available in the workbook ‘FM4, Chapter 
31, data tables.xlsm’, in the tab ‘Pages 823–26’. 

Benninga (2014) 
Chapter 31 ‘Data tables’ 
in Financial Modeling. 
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Examine what happens to the cash flows, and the data table for NPV and IRR, if you 
change the cash flow in year 1 from 234 to 300. Hint: If the projected cash flows in years 
1 to 7 change, but NPV and IRR in the data table do not change, use the ‘Calculate Now’ 
button on the ‘Formulas’ tab. 

 

Let us now return to our example and create a chart for the call option profit 
pattern shown in Figure 1.5 in your Hull (2018). The strike price is $22.50, 
the call option premium is $1, and the illustrative range of stock prices at 
maturity is $15–$30. The formula for the call option profit requires a particu-
lar stock price at maturity – let us choose the current stock price, $20. The 
example in Figure 1.5 is for 2,000 options. To demonstrate the principles of 
creating a data table we will consider the profit from purchasing one call 
option. 

The profit pattern has been created in the file ‘M482 U1 Application Profit 
pattern long call option.xlsm’. Within this file: 

• the terminal stock price is in cell B3 
• the exercise price is in cell B5 
• the call premium is in cell B7 
• the call option profit formula, given by equation (1.3), is in cell B9. 

The formula in B9 is shown using Getformula in cell C9, and 
FORMULATEXT in C10. 

The call option profit using the values we have suggested is minus $1. The 
stock price of $20 is less than the strike price of $22.50, the call option is not 
exercised, but the call premium has been paid. 

Now let us create the data table. 

In the first row of the data table, the entry for the long call profit references 
the cell containing the formula for the call option profit, so the formula is 
‘=B9’. (Note that if we wanted to consider 2,000 call options we could change 
this formula to ‘=2000*B9’.) 

We place the range of terminal stock prices starting in the next row down, 
starting at $15 and going to $30, and we have chosen a step of $0.50. 

To create the data table select the column of terminal stock prices and the 
formula referencing the call option profit formula, so cells C14:D45. Then go 
to Data>What-if Analysis>Data Table… 

The range of terminal stock prices is arranged in a column. Leave the Row 
input cell blank. The column input cell is the terminal stock price in cell B3. 
(To conduct the What-if Analysis the data table will substitute each of the 
stock prices in the range for the contents of cell B3.) 

If your Excel Calculation Option is set as ‘Automatic Except for Data Tables’, 
the call option profit for the range of terminal stock prices in the data table 
will be −1. Why is that? If this happens, refresh the data table using the 
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Calculate button. You should now have a range of call option profits starting 
at −1 for terminal stock prices $15 to $22.50, then −$0.50 rising to $6.50. 

Now you can create the chart of the call option profit profile. The input 
range is the column of terminal stock prices and long call profit (not includ-
ing the cells C14 and D14), and the chart type is ‘Scatter with Straight Lines’. 

 Exercise 1.7 

For the call option and the stock in Exercise 1.4 (question 1.9 on page 42 of Hull) create a 
data table and chart showing how the profits change for various values of the terminal 
stock price. 

1.8 Conclusion 
This unit has introduced the most common types of financial derivatives: 
forward contracts, futures and options. You have studied their different charac-
teristics and have started to learn how you can use them to modify the payoff of 
your investment profile. You have also constructed simple profit patterns using 
data tables. In the next units of this module you will build on the basic concepts 
and techniques presented in this unit and you will learn how you can construct 
very complex risk profiles by making use of derivatives instruments. 

1.9 Solutions to Exercises 
Here are the answers to the exercises you’ve been assigned for this unit, but 
please don’t check the answers until you’ve worked them out for yourself. 

Exercise 1.1 

a) At the end of the contract the investor sells 100,000 British pounds for 
US dollars at an exchange rate of 1.5000 US dollars per pound, 
whereas the spot exchange rate on maturity is 1.4900. The investor 
therefore gains 100,000 × (1.5000 − 1.4900) = $1,000. 

b) At the end of the contract the investor sells 100,000 British pounds for 
US dollars at an exchange rate of 1.5000 US dollars per pound, when 
the spot exchange rate on maturity is 1.5200. The investor therefore 
loses 100,000 × (1.5200 − 1.5000) = $2,000. 

Exercise 1.2 

a) The trader commits herself to selling 50,000 pounds of cotton at the 
end of the contract at a price of 50 cents per pound. If the spot price of 
cotton at maturity is only 48.20 cents per pound, she will gain 50,000 × 
(0.5000 − 0.4820) = $900. 

b) The trader must sell 50,000 pounds of cotton at the end of the contract 
at a price of 50 cents per pound, when the spot price of cotton at 
maturity is 51.30 cents per pound. She will therefore lose 50,000 × 
(0.5130 − 0.5000) = $650. 
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Exercise 1.3 

You have sold a put option, and therefore you have a short position on a put 
contract. You have received the option premium, and have committed 
yourself to buying 100 shares at a price of $40, if the party who has pur-
chased the put option decides to exercise her right to sell the shares at the 
exercise price. At present, it would not be profitable to exercise the option 
because the market price of each share is $41.  

The investor who has purchased the put option will only find it profitable to 
exercise it if the stock price falls below $40. For instance, if the stock price 
falls to $30, the holder of the put option could purchase the shares at $30 and 
sell them to you at $40. She will have made a profit of 100 × (40 − 30) = 
$1,000, minus the price of purchasing the option contract. You will have to 
buy the shares at $40, although their market price is only $30. You will 
therefore have made a loss of $1,000, minus the premium that you have 
received from the option holder. 

Exercise 1.4 

One strategy that you can implement is to purchase 200 shares (5,800/29); 
the alternative strategy would be to purchase 2,000 call options (5,800/2.9). 
The table below illustrates the payoffs associated with each one of the two 
strategies when the stock price increases to $40 and when it declines to $25. 
When the stock price increases to $40, your profit from the first strategy will 
be 200 × ($40 − $29) = $2,200, and [2,000 × ($40 − $30)] − $5,800 = $14,200 
from the second strategy, if you exercise your call option and purchase 
stocks at the strike price of $30. By contrast, when the stock price falls to $25 
your losses will be 200 × ($29 − $25) = $800 from the first strategy, but will 
amount to your whole investment of $5,800 because you will have to let 
your options expire unexercised. 

Table 1.1  

 
Strategy 

Stock price 

$25) $40 

Buy 200 shares ($800) $2,200 

Buy 2,000 call options ($5,800) $14,200 

You can verify that the second strategy yields larger gains when the stock 
price increases, but also larger losses when the stock price falls. 

Exercise 1.5 

The put option will be exercised against the trader if the stock price is less 
than $30 in December. If we consider the price that the trader has received 
for issuing the option, she will make a profit provided the stock price in 
December is greater than $26 (ignoring the time value of money). 
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Exercise 1.6 

With futures and options, the gain to one party must always be equal to the 
losses suffered by the other party. Hence, if we add up the payoffs to both 
parties, they must always add up to zero. Graphically, the payoff from a 
short position is the mirror image of the payoff from a long position (that is, 
it is symmetrical about the horizontal axis). 

Exercise 1.7 

The initial share price is $29. A call option with strike price $30 costs $2.90. 
With $5,800 available to invest, it is possible to purchase 2,000 call options or 
200 shares. 

The formula for the profit from the call option is given by equation (1.3) 

( )max ,0TS K c− −  
and the formula for the profit from investing in shares is 

0TS S−  
where: 

0S  is the initial stock price. 

The data table and chart showing the profit from two strategies, investing in 
the stock or the call option, for a range of stock prices at maturity of $25 to 
$40, is included in the file ‘M482 Exercise 1.7 Profit pattern stock or long 
call.xlsm’. The chart is also shown in Figure 1.1. 

Figure 1.1 Profits from purchasing shares or call options 
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